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Formatting Your Document forFormatting Your Document forFormatting Your Document forFormatting Your Document for
Onscreen Reading:Onscreen Reading:Onscreen Reading:Onscreen Reading: ((((TitleTitleTitleTitle))))
An MS Word Template for Producing Screen-
Friendly PDF Documents (Subtitle)
Paul Royster, Coordinator of Scholarly Communication,
University of Nebraska–Lincoln (Author)
Abstract: The traditional 8.5” x 11” page is not very convenient or
reader-friendly for publications delivered electronically and read on-
screen. At normal font sizes, the line is too long (over 85 characters)
for easy reading in single-column format, and in double-column for-
mat, the reader must jump up or down three times to read the com-
plete page. This file is a MS Word document template (suffix .dot) that
creates a page format to present the text in two-page spreads, each
of which fits on a single screen (of 1024 x 768 pixels) and remains
readable at 75% magnification. It includes design and typographic
settings engineered to accommodate most text elements: headings,
subtitles, extracts, etc. (Abstract text is 9-point, justified, with no
paragraph indent.)

Examples (This is Heading 1Examples (This is Heading 1Examples (This is Heading 1Examples (This is Heading 1))))
This is a “first text paragraph.” This style should be used
after the title or subtitle and headings of all kinds. It
does not have a paragraph indent. In the template, this
style is automatically invoked after Heading 1, Heading 2,
or Heading 3.

Even Page Header (right aligned)
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This is a “body text” paragraph—used for the second
through n-th paragraph of a section. It has a paragraph
indent of .25”. In the template, this style is automatically
invoked after a “first text paragraph” and after another
“body text” paragraph.

The style for Heading 1 has an 18-point vertical space
above and a 6-point space below. The font is 14-point
bold.
Heading 2Heading 2Heading 2Heading 2
Above is an example of Heading 2, the next level down in
importance from Heading 1. It is in 12-point bold italic
(compared to 14-point bold for Heading 1). It has 12-
point space above, and is followed by a 6-point vertical
blank space, and then by a “first text paragraph” style.
Heading 3Heading 3Heading 3Heading 3
Above is an example of Heading 3, the next level down in
importance from Heading 2. It is in text-size 11-point
bold (compared to 12-point bold italic for Heading 2). It
has 12-point space above, no blank space below, and is
followed by a “first text paragraph” style.

Overall StyleOverall StyleOverall StyleOverall Style
The default font is Lucida Sans UnicodeLucida Sans UnicodeLucida Sans UnicodeLucida Sans Unicode, set single-
spaced. It is a sans serif font, which allows for greater
readability at smaller sizes. It is also a Unicode font,
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which accommodates most special characters. It is engi-
neered with a tall line-height, so that even set “solid”
(i.e., single-spaced) there is ample “leading” between the
lines for clear reading.

The overall design is “left aligned”—that is all titles,
subtitles, headings, etc. are lined up on the left margin.
This makes for a more consistent look than centering
variable-length headings—which produces a confusing
assortment of indents.

The page layout has a top margin of .5” to the header
and .8” to the start of the text page. The text block ends
1” above the end of the page; and the bottom “footer”
containing the page number is .5” from the edge of the
sheet.

The outside margin is .8” and the inside (gutter) mar-
gin is .4” on each side (for a total of .8”). [Because of the
peculiarities of MS Word, the “Page Setup” screen shows
the “inside” and “outside” margins reversed: Oh! Mr.
Gates, you are a sly dog!] This creates a spread layout of
two equal columns separated by three equal spaces.

Also in the “Page Setup” menu, you may see that the
file is set up in landscape orientation and for printing “2
pages per sheet” on Letter-size 8.5” x 11” paper. This
creates a spread where page 1 (and all odd-numbered
pages) are on the left and page 2 (and all even-numbered
pages) are on the right—in gross violation of the centu-
ries-old dictum in book publishing that “rectos” are odd
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and “versos” are even. But this is a file for screen display,
so we can live with that, I suppose.

The HeadersThe HeadersThe HeadersThe Headers
At the top of the pages (except the first page) are the
headers. They are different for odd and even pages so
that they can be aligned to the outside margin.

I recommend you use the odd page header for the
author names (shortened to last names only, if necessary)
and the even page header for the short title of the article.
You can access the headers in MS Word by selecting View
— Header and Footer. They will be the same for all pages
except the first page (where they should be blank).
Headers type style is 9-point.

Block Quotes and Block Text StylesBlock Quotes and Block Text StylesBlock Quotes and Block Text StylesBlock Quotes and Block Text Styles
Occasionally you need to include a block quote in your
article—an excerpt that runs more than 3 lines of quoted
material.

This is called in MS Word a “Block Text,” and
the style for it has been set up. It has no
paragraph indent; left and right margins are
indented an additional .5”; and there is a
12-point space above and below.
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Sometimes, that excerpt runs more than a single
paragraph, so in those cases you need to resort to “Block
Text for multi-paragraph” style followed by “Block Text
2nd”; these are like Block Text, but Block Text for multi-
paragraph has no trailing 12-point space below, and
“Block Text 2nd” has a paragraph indent of .2” and also no
trailing 12-point space below.

This is an example of “Block text for multi-
paragraph” style, used for the initial para-
graph of a multi-paragraph block quote.

It is followed by this style, which is “Block
Text 2nd”—which has a .2” paragraph
indent. If this is the final paragraph of the
block quote, then you will need to manually
select the last paragraph and add a 12-
point space afterwards. You do this in MS
Word by selecting Format — Paragraph and
then increasing the “Spacing after” from 0
to 12 points—unless the next thing is a
heading, as it is here.

Lists, Unnumbered,Lists, Unnumbered,Lists, Unnumbered,Lists, Unnumbered, Bulleted,Bulleted,Bulleted,Bulleted, andandandand NumberedNumberedNumberedNumbered
There are three kinds of list styles already set up. They
are:

List (this is an example of List style)
List, Bullet
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List, Number
The regular (unnumbered) List style calls for a .25”

indent for each item, and a .5” indent for lines that run
over. It is left aligned, i.e., unjustified. There is a 12-
point space after the list, but no extra space between
items in the same list.

A bulleted list (List Bullet style) works the same way,
and puts a single bullet before each item:

• List
• List, Bullet (this is an example of List Bullet style)

and some extra text to show the run-over
indent

• List, Number
A numbered list, using List Number style, also works

the same way, except the bullet is replaced by a con-
secutive number. These can be very useful, but they can
also drive you crazy sometimes since the number is
auto-generated it is not subject to re-formatting for size,
italics, etc.

1. List
2. List, Bullet
3. List, Number (this is an example of List Number

style) and some extra text to show the run-
over indent
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Illustrations and CaptionsIllustrations and CaptionsIllustrations and CaptionsIllustrations and Captions
One of the marvelous features about the MS Word-to-
PDF filters created by Adobe is that they handle illustra-
tions almost effortlessly. You can insert an illustration in
the MS Word file by selecting Insert – Picture – FromFile
and placing it directly into the document. Adjust the size
with the corner handles; using the side handles distorts
the aspect ratio. If your file default is single-spaced (as
this one is), your picture pops right up. If the line height
has been changed to a constant, then you will need to
use Format – Paragraph to reset the line height for the
line with the picture to single. Or, select the Illustration
style, which is single-spaced, adds 12 points space
above and 6 points below, and is centered on the text
width. Among the supported file types for illustrations
are jpg, gif, tiff, png, and bmp.

Even Page Header (right aligned)
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Sample illustration caption using Caption style.
Style is 10 point, centered italic. I suggest

breaking lines that run past corners with soft
line-break [Shift+Enter].

A .png file showing a drawing of an AIDS virus.
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Links, Hyper and OtherwiseLinks, Hyper and OtherwiseLinks, Hyper and OtherwiseLinks, Hyper and Otherwise
Another nice feature of the PDF filters is they preserve
hot links from the original Word files, so go ahead and
put them in. This document is intended for archiving at
http://digitalcommons.unl.edu and that address should
show in Hyperlink style, which is blue and underlined. If
you clicked it already, it should show in Followed
Hyperlink style, which is purple and underlined. You can
insert hyperlinks from the Insert menu, or you can copy
and paste them from your browser.1

On Typography,On Typography,On Typography,On Typography, etc.etc.etc.etc.
Users should feel empowered to adjust, re-adjust, adapt,
and change these settings as they wish. I would offer
only two pieces of advice.
Keep It SimpleKeep It SimpleKeep It SimpleKeep It Simple
Too many styles, sizes, indents, etc., can give a docu-
ment a “ransom note” appearance. Use as few styles,
fonts, alignments as possible. Less is more, by far. Don’t
let the design distract from the content.
The Secret to Good JustificationThe Secret to Good JustificationThe Secret to Good JustificationThe Secret to Good Justification Is . . .Is . . .Is . . .Is . . .
Hyphenate, hyphenate, hyphenate; but wait till the end of
the process. Justification helps the reader go faster and
find things more easily, but it can produce problemati-
cally loose lines that are distracting and unsightly.
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Breaking long words into smaller pieces helps even out
the setting and “color” of the text. MS Word will hyphen-
ate automatically if you let it; look under the Tools – Lan-
guage menu. It will also hyphenate “manually,” i.e., on
command and let you say yes or no to each suggested
word break. I am personally a purist, who doesn’t like to
see two-letter syllables broken off, but I’d rather see that
than loose lines and ragged setting.

Viewing the DocumentViewing the DocumentViewing the DocumentViewing the Document
Microsoft WordMicrosoft WordMicrosoft WordMicrosoft Word
The MS Word document can be viewed as a two-page
spread by selecting “Two pages” in the magnification
window on the Standard Toolbar. MS Word will claim to
be showing it at around 70% magnification (depending on
how many toolbars and other things are on screen
besides the document), but it is actually closer to 90% of
8.5” tall by 11” wide.2 The 11-point Lucida Sans font is
large enough to be read comfortably at this size, and the
10-point is also readable. (The 9-point type is border-
line.)

The file will print out as 2 pages on a 8.5” x 11” sheet
of letter-size paper.
Adobe PDFAdobe PDFAdobe PDFAdobe PDF
When the file is distilled or filtered into a pdf format, it
emerges as two pages per 8.5” x 11” (landscape) page.
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The DigitalCommons PDF filter adds a single-page title
page at the front; this added title page (generated by
LAτεκ) is in portrait orientation, but the rest of the file
remains landscape oriented.

The pdf document will print out conveniently on nor-
mal paper, and can be viewed as two-page spreads at
magnification of 75% to 80% (so-called) onscreen.3

The Set of FilesThe Set of FilesThe Set of FilesThe Set of Files
There are three files associated with this template and

explanation:
1. a MS Word template, named “EEEE----Pub format.dotPub format.dotPub format.dotPub format.dot”.

This is a blank (or rather, empty) template, with all the
styles discussed and illustrated here, included and active.
It is an attachment to the PDF file archived at
http://digitalcommons.unl.edu/ir_information/ You can
open this file and save it (as a template, suffix “.dot”) to
your MS Word templates; these are generally located in
“C:\Program Files\Microsoft Office\Templates”. When you
open a “New” file in MS Word, you can select this tem-
plate for the new document. Turn on “Styles and Format-
ting” from the Format menu, so you can see the styles
listed and displayed on the side of the screen.

2. a MS Word document file, named “EEEE----Pub formatPub formatPub formatPub format
sample.docsample.docsample.docsample.doc”. This is the original document file for what
you see here. It is also an attachment to the PDF file at
http://digitalcommons.unl.edu/ir_information/ . You can
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open this file, insert your own text and illustrations
instead of what is currently here, and “Save As” a file-
name of your own choosing. The present text can serve
as a guide for matching styles. Again, be sure to turn on
“Styles and Formatting” from the Format menu, so you
can see the styles listed and displayed on the side of the
screen.

3. a PDF file, named “Formatting Your DocumentFormatting Your DocumentFormatting Your DocumentFormatting Your Document forforforfor
OnscreenOnscreenOnscreenOnscreen Reading: An MS Word Template for ProducingReading: An MS Word Template for ProducingReading: An MS Word Template for ProducingReading: An MS Word Template for Producing
ScreenScreenScreenScreen----Friendly PDF DocumentsFriendly PDF DocumentsFriendly PDF DocumentsFriendly PDF Documents”. This is the file archived
at http://digitalcommons.unl.edu/ir_information/

Very Brief HistoryVery Brief HistoryVery Brief HistoryVery Brief History
This template (and associated materials) are the result of
experience and (often painful) trial and error attempts to
reach some readable accommodation among the com-
puter screen, historically standard paper sizes, and the
various Adobe Acrobat/Reader/Distiller filters for auto-
matically converting files for archiving and onscreen
delivery.

Most computer screens have an aspect ratio of 4/3, or
1.333. The standard American paper page has an aspect
ratio of .773. I suppose we could all set our screens
sideways and just go on, but that would be inconvenient,
wouldn’t really work, and isn’t all that funny.

There is no reason that electronically delivered docu-
ments should have to conform to the historical sizes of
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physical paper products, except that it is occasionally
convenient to print them out, and this “template” accom-
plishes that in both Word and PDF environments.

I hope this format for documents looks better,
onscreen and off, and is more readable and convenient to
use than the traditional 8.5” x 11” portrait size. I would
welcome comments and suggestions—my present email
is proyster@unl.edu.

July 8, 2005

1 This is a sample endnote, showing Endnote style. It is 10-
point type, single-spaced, non-justified, with the first line
indented .25”. There is 6 points space after each note.

2 My version MS Word claims to show it at 70%, but it
actually measures 9-3/4” x 7-7/8” on the screen (measured
with a ruler against the glass), which is 87% of true width and
93% of true height.

3 My version of Reader fits the 11” x 8.5” spread in a single
screen at 77% (so-called); the actual measured size onscreen is
10.25” x 8.6”, which is 93% horizontally x 101% vertically (go
figure!).


	University of Nebraska - Lincoln
	DigitalCommons@University of Nebraska - Lincoln
	7-8-2005

	Formatting Your Document for Onscreen Reading: An MS Word Template for Producing Screen-Friendly PDF Documents
	Paul Royster


